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      Excel is one of the most powerful software programs for a normal every day user. I would be lost without it at work and I’m not quite sure how I’d keep track of monthly bills without it. (Probably in the margin of a notebook like I used to in the old days.)

      But it can be really intimidating for a new user to learn. Especially if you pick up a book that’s trying to cover everything you can possibly know in Excel. Because the program can do SO MUCH. This is my fourth time writing a series of books on Excel, and I’d say each time I cover maybe 30% of all the possible things that Excel can do. And yet the collection still ends up being an inch thick in print.

      Good news, though, by the time you’re done with this first book in the series, you’ll know about 90-95% of what you need to know to use Excel on a daily basis, and you’ll have a good idea of how to learn the rest.

      My goal is to give you what you need to know without bogging you down in a lot of stuff you don’t need to know. Intermediate Excel 2024 and Excel 2024 Useful Functions, which are the next two books in this series, will keep you going if you want to learn more. But by the time you’re done with this book you should feel comfortable opening Excel, entering and moving data around, formatting it, doing some basic analysis, and printing your results.

      I want to show you that Excel does not have to be scary, and that anyone can learn it.

      Now, that does mean I start with the basics of all basics and cover things like terminology, opening Excel, starting a new file, saving in Excel, etc. For those who already know that, I think there’s still value to be had here. We’ll cover sorting, filtering, and basic formulas, too. But you can also just jump ahead to the other titles in the series. That’s why there are multiple titles. So people can jump in where they need to.

      (And if you have some experience and want a little taste of how I teach, check out Excel Tips and Tricks which should be free in ebook and provides some simple time-saving tricks I’ve learned over the years.)

      One more thing to note before we get started. This book is written for users of Excel 2024. At the beginner level, most of what you learn here can be used in any version of Excel. What differentiates this book and the original Excel title I wrote, Excel for Beginners, is that I’m not going to hold back on telling you new ways of doing things that are available in Excel 2024 but weren’t in earlier versions of Excel.

      Again, at the beginner level there’s not too much of that. But if you continue with this series then things like pivot charts and the newer functions will be something you can use in Excel 2024 (or Excel 365) but not in earlier versions of Excel. That backwards compatibility issue is probably less of a concern these days than it was back in the day, but I once wasted a week using a function that was available in my version of Excel only to figure out it wasn’t available to my consulting client and had to redo everything as a result. Not fun.

      Anyway. Your big difference as a beginner in Excel will be the appearance of Excel 2024 versus earlier editions. It seems with each release they like to streamline things more and more so that they are less visually intuitive. Fine for someone like me who has been using variations of Excel for over 30 years, not so great for a new user.

      Also, know that my screenshots may look slightly different from what you see on your screen. That’s because the section at the top of Excel will display differently depending on the screen size of the computer you’re on. Also there are various appearance settings that can impact how Excel looks. Things should always be in the same location, though, so if you get lost look for the little image (the icon) for each option, or for a dropdown menu with that section name.

      Okay. First up, basic terminology.

    

  


  
    
      
        
          
          

          
            TERMINOLOGY

          

        

      

    

    
      This chapter includes terms that I’m going to use throughout the rest of the book and also starts some of your basic learning. So even if you think you know Excel, be sure to skim it just in case.

      

      
        
        Workbook

      

      

      A workbook is basically an Excel file.

      Workbooks are made up of worksheets. While the default for a workbook in Excel 2024 is to have one worksheet, you can easily add more.

      

      
        
        Worksheet

      

      

      According to Microsoft, a worksheet is “the primary document that you use in Excel to store and work with data.” Worksheets consist of “cells that are organized into columns and rows”.

      That is the official definition, but in more recent versions of Excel I have seen worksheets that did not have columns and rows. They were simply blank pages that could display an image. So the better way to think of a worksheet is as a discrete location in your workbook that contains information. (We will not deal with any situations that involve those blank pages, though, so feel free to forget that for now.)

      Note that the Office folks also sometimes refer to a worksheet as a spreadsheet. I don’t, because to me that can also mean a workbook.

      

      
        
        Cell

      

      

      Cells are formed by the intersection of a column and a row, and are referred to based upon the column and row where they are located.

      So the first cell in a worksheet is Cell A1, where A is the first column and 1 is the first row. When a cell is selected, you can see a border around the edge of the cell, like here where Cell A1 is selected:

      
        
          [image: Image of the top left corner of an Excel worksheet with Cell A1 pointed out.]
        

      

      When you enter information into a worksheet, it is almost always entered into a specific cell. You can then refer to that cell to use that information.

      Cells generally will contain text, numeric values, or formulas.

      

      
        
        Column

      

      

      A standard worksheet uses columns and rows to create cells which display your information. Columns run across the top of the worksheet and are, by default, indicated with a letter. Here is the top left corner of a worksheet:

      
        
          [image: Image of the top left corner of an Excel worksheet with Columns B, C, and D pointed out.]
        

      

      See the letters running across the top there? A, B, C, D, etc.? Each of those letters is at the top of a column.

      Every Excel 2024 worksheet has the exact same number of columns. Scroll far enough to the right and the columns will start a double alphabet of AA, AB, AC, etc. This will continue into a triple alphabet AAA, AAB, etc. The very last column in an Excel 2024 worksheet is XFD.

      

      
        
        Row

      

      

      Rows run down the side of a worksheet and are numbered from 1 up to the very last row, which in Excel 2024 is 1,048,576.

      Here is that image above but with the rows pointed out instead:

      
        
          [image: Image of the corner of an Excel spreadsheet with Rows 2, 4, and 6 pointed out.]
        

      

      (Note that the number of rows and columns in a worksheet is one area where different versions of Excel can be incompatible. I wrote the first Excel book in Office 2013. In that version, the maximum number of rows was 65,536. You cannot take data that fills all of the rows in a worksheet in Excel 2024 and transfer it to a worksheet in Excel 2013. It wouldn’t fit.)

      

      
        
        Click

      

      

      You probably already click on things all the time without thinking about it, but just in case.

      If I tell you to click on something, that means to use your mouse (or trackpad) to move the arrow on the screen to a specific location, and then to left-click or right-click (as defined below).

      In general, a left-click will select an item whereas a right-click will create a dropdown list of options to choose from.

      If I don’t tell you which one to use, left-click.

      

      
        
        Left-Click/Right-Click

      

      

      If you use a standard mouse, then it’s going to be split in the middle with the option to press down on either side. Press on the left side and that’s a left-click. Press on the right side and that’s a right-click.

      With trackpads it can be a little trickier, because they sometimes get creative about where they put things. On my current computer I can left-click on my trackpad by either clicking on a flat button at the top of the trackpad or by pressing in the bottom left corner. Right-click also has two options, a visible button at the top right and pressing in the bottom right corner of the trackpad itself.

      If you’re not sure how to left- or right-click on your computer, experiment a bit. I will mention times to use one or the other throughout this book that you can use as your test cases.

      

      
        
        Left-Click and Drag

      

      

      I may at times tell you to left-click and drag something. What this means is to left-click on that object or in that location, and then hold your left-click as you move your arrow/mouse/cursor to either select a range or to move an object.

      

      
        
        Formula Bar

      

      

      The formula bar is the long white bar at the top of the Excel workspace with the function(x) (ƒ) symbol next to it.

      
        
          [image: Image of the top corner of an Excel worksheet with the formula bar pointed out.]
        

      

      When you click onto a cell, like I have here in Cell C1, the formula bar will show you the contents of that selected cell. If the contents of the cell are just text or numbers you typed in, that’s what you’ll see. But if a formula was used instead, the formula bar will display the formula that was used.

      This is useful because by default the cells in a worksheet only display the results of any formulas that were used.

      Above, for example, I used a formula in Cell C1 that adds the value in Cell A1 to the value in Cell B1. You can see the result of the formula, 5, in Cell C1, and the formula used, =A1+B1, in the formula bar.

      

      
        
        Tab

      

      

      I refer to the menu choices at the top of the screen (File, Home, Insert, Page Layout, Formulas, Data, Review, View, Help, etc.) as tabs. Learn this because I am going to use it about a hundred times throughout this book. Maybe more.

      I use the term tab because in the past when one of those options was selected, it looked like the top of a file folder. That’s no longer the case. In Excel 2024, the selected tab is just underlined, like here with the Home tab:

      
        
          [image: Image of top corner of an Excel worksheet with the Home tab pointed out.]
        

      

      Each tab gives you different tasks you can perform. The Home tab, for example, lets you Paste, Cut, Copy, apply text formatting, and more.

      

      
        
        Section

      

      

      I refer to the different named areas under each tab as a section. The names are at the bottom of the section.

      For example, here I have isolated the Font section of the Home tab:

      

      
        
          [image: Image of the top section of Excel with the Font section of the Home tab pointed out. (Other sections are grayed out.)]
        

      

      
        
        Data

      

      

      I use the terms data and information interchangeably. Whatever information you have in your worksheet is your data.

      

      
        
        Table

      

      

      I will sometime refer to a table of data or data table. This is just a collection of cells that contain related information and appear to be formatted to belong together.

      (In Excel 2024 it looks like Microsoft has introduced a data table concept that is separate and distinct from this. I am not using table or data in that way. We are not that fancy. I just mean a group of data that belong together.)

      

      
        
        Scroll Bar

      

      

      When there is more information than Excel can show you on the screen, it will make scroll bars available so you can “scroll” to see the rest of the information. Scroll bars appear either on the right-hand side or along the bottom when needed.

      The primary place you’ll see scroll bars is in a worksheet when you have more data in the worksheet than is visible. Here, for example, I have added text into a number of cells in Row 1 and in Column A so that there is data that continues outside of what you can see:

      
        
          [image: Image of the bottom right corner of an Excel worksheet with scroll bars pointed out.]
        

      

      Excel made scroll bars available to navigate all of that data.

      Each scroll bar section consists of a light gray scroll area with a darker gray bar that marks where you are in the data. So here, for example, you can see that I am at the very top and far left of the data because the darker gray bars are positioned that way in the scroll bar area.

      Scroll bars only let you navigate within the rows and columns where there’s data entered. To go past that you can use the arrows at the ends of the scroll bars.

      There are a few ways to navigate using scroll bars. One way is to left-click and drag the dark gray bar up and down or side-to-side within the light gray scroll area. As you drag the right-hand bar up or down, or the bottom bar left or right, the visible columns and rows in your worksheet will change.

      You can also click into the light gray portion of the scroll bar area to move approximately one screen’s worth of columns or rows at a time. It’s slower than clicking and dragging the scroll bar itself, but sometimes it’s the better option when you want to look through all of the data.

      The arrows at the ends will move you one column or row at a time.

      Be sure to click into a cell in your current workspace if you use scroll bars to navigate your worksheet. Until you do, if you use Enter or the arrow keys, you’ll be moving from whatever cell you were last clicked into, which may be hundreds of rows away. (This happens to me often, especially when using freeze panes, which we’ll cover later.)

      

      
        
        Select

      

      

      When I refer to a selected cell it means the cell you’re clicked onto, like above with Cell A1 under the definition of cell. As mentioned above, a selected cell will have a different border around it.

      It is possible to select a range of cells. To do so with a range of cells that are touching, left-click and drag from a cell at one of the outer corners of the range until all of the cells you want are highlighted.

      When you do that, all of the selected cells will be surrounded by a border. Within that border, the first cell you clicked on will be white and the rest will be gray. Like so:

      
        
          [image: Image of the top left corner of an Excel worksheet with a range of cells selected.]
        

      

      Here I left-clicked on Cell A1 and dragged to Cell D7.

      Another way to select cells that are next to each other is to click into the first cell you want, then hold down the Shift key as you use the arrow keys to select other cells.

      It is also possible to select cells that aren’t touching one another. To do so, select the first cell or range of cells like above, but then hold down the Ctrl key while you select the second cell or range of cells. When selecting ranges of cells, let up on your left-click and drag each time. You can select as many cells or ranges as you want as long as you hold down the Ctrl key each time before you select new cells to add.

      (To unselect a cell or cell range, hold down the Ctrl key and click on that cell or cell range again.)

      Here I’ve selected Cells A1 to B2 as well as Cells D3 to E5 and Cells A5 to B5:

      
        
          [image: Image of the top left corner of an Excel worksheet with three different sets of cells selected.]
        

      

      Each selected range of cells is shaded in gray. The cell I first clicked on for the last selected range, Cell A5, is white with a border around it.

      When you have more than one cell selected, the one that’s white with a border is the one you can type into, but you can format all selected cells at once. (And what I usually use this for, have Excel take that selected cell range and use it in your formula.)

      One final comment. To select an entire column or an entire row, just click on the letter for the column or number for the row around the perimeter of the cells in that worksheet.

      

      
        
        Dropdown Menu

      

      

      I will often refer to dropdown menus or dropdowns, which are a list of potential choices that you can select from that aren’t immediately visible. In the set of menu options up top, the existence of a dropdown menu is indicated by an arrow next to that option. In this image you can see dropdown arrows next to Paste, Copy, Font Choice, and Font Size.

      
        
          [image: Image of the top section of Excel will dropdown arrows for Paste and Copy pointed out and the Font dropdown menu visible.]
        

      

      I’ve clicked on the arrow for font choice, and you can now see a dropdown menu of other fonts.

      (Note also that there is a scrollbar in the font dropdown menu since there are more available fonts than can be displayed at one time.)

      

      
        
        Dialogue Box

      

      

      Dialogue boxes are pop-up boxes that appear on top of your workspace. They contain a set of available options to choose from. This is the Insert dialogue box, for example:

      
        
          [image: Insert dialogue box.]
        

      

      It lets you “insert” cells into a spot on your worksheet. (The number of cells in a worksheet is actually fixed, so what it’s really doing is just shifting your existing data to make blank cells available at that particular spot.)

      Dialogue boxes are less common now—I think they’ve largely been replaced by the use of task panes for newer functionality—but they still exist for older functionality, and often contain more options than the menus do.

      To close a dialogue box, either make your selection and click OK, click Cancel, or click on the X in the top right corner.

      

      
        
        Task Pane

      

      

      Task panes are separate spaces that can appear to the left, right, or bottom of the worksheet area. They allow you to perform various additional tasks.

      The easiest one to see is the Clipboard task pane, which will open if you click on the expansion arrow in the bottom right corner of the Clipboard section of the Home tab:

      
        
          [image: Top left corner of an Excel workspace with the Clipboard task pane visible next to a worksheet and the Clipboard Expansion Arrow pointed out.]
        

      

      To close a task pane, click on the X in the top right corner of the pane.

      

      
        
        Expansion Arrow

      

      

      Some of the sections in the tabs have what I refer to as expansion arrows. These are arrows in the bottom right corner of that section which open either a dialogue box or a task pane that contains more choices.

      For example, the expansion arrow for the Font section of the Home tab will open the Font dialogue box:

      
        
          [image: Top section of an Excel worksheet with the Font expansion arrow pointed out and Font dialogue box visible.]
        

      

      If you are ever looking for something you think you should be able to do and can’t find it, it’s always worth clicking on one of these to see what else is available.

      

      
        
        Cursor

      

      

      Your cursor is what moves around when you move your mouse. Depending on where you are, it will look like different things. Often in Excel it looks like a variety of arrows, so I may tell you to move the arrow around or the cursor around or even to move the mouse around. All three just mean to get that thing that moves on the screen to a specific spot so you can click.

      Pay attention to what your cursor looks like, because the different shapes mean that you can do different things.

      

      
        
        Arrow

      

      

      If I ever tell you to arrow to something, that means to use the arrow keys to navigate to that spot. When you’re clicked into a cell in a worksheet, the arrow keys will move you one cell in the direction of the arrow.

      (Note that you can also use the Tab key to move to the right one cell, and Shift + Tab to move to the left, but I’ll probably avoid telling you to do that since it can be confusing when I refer to the menu options as tabs.)

      

      
        
        Control Shortcut

      

      

      There are various keyboard combinations that you can use in Excel to perform common tasks. I refer to them as control shortcuts, because most use the Ctrl key, but not all of them do. For example, Shift + Tab. A very common one to use is Ctrl + C, which lets you copy your selection.

      Note how I write these. I have something, then a plus sign, and then something else. That means to hold down both of those keys at the same time.

      So to copy, you would hold down the Ctrl key (bottom left of the keyboard for me) and the “c” key. I capitalize them when I write them, but you don’t need to do that, just select that letter.

      Or, with Shift+Tab, hold down Shift and then press down on Tab as many times as you need to move to your location.

      You don’t have to learn these, but they can be incredibly useful and time-saving. They mean you don’t have to take your hands away from the keys to perform certain tasks, which is very nice.

      
        
          
            [image: ]
          

        

      

      Okay, now it’s time to dive in on how to actually use Excel.

    

  


  
    
      
        
          
          

          
            ABSOLUTE BASICS

          

        

      

    

    
      This is the chapter that many may already know and can skip, but it may be worth skimming because you don’t know what you don’t know. I, for example, never used to use a control shortcut to open a new file until I learned it writing these books. Now I use it regularly.

      

      
        
        Open Excel

      

      

      If you’re creating an Excel file from scratch, then your first step needs to be opening Excel, so let’s cover that real quick.

      If you just installed Microsoft Office, then Excel may be listed in your start menu (generally available by clicking on the Windows icon at the bottom of the screen).

      Otherwise, use the search bar at the bottom of your screen or in the start menu to look for Excel. Click on Open when Excel appears on the right-hand side.

      
        
          [image: Windows task screen showing Excel with arrows to options that let you pin Excel to your taskbar, as well as an arrow to the Search option in the taskbar.]
        

      

      I personally like to pin my favorite programs to the bottom of my screen in the taskbar so I can open them easily by just clicking on the icon down there when I need to open Excel.

      To do that, you can either right-click on the image of Excel in your search listing and choose Pin to Taskbar (on the left side in the image above). Or you can expand the menu under Open (on the right side above) and click on it there.

      

      
        
        Create a New Excel File

      

      

      Excel will normally open to the Welcome Screen.

      
        
          [image: Top portion of the Excel Welcome screen showing the Blank Worksheet option.]
        

      

      From there the easiest way to start a new Excel file is to click on the Blank Workbook option in the top row.

      If you’re already working in an Excel file and want to open another one, then the easiest choice is to use Ctrl + N.

      Or you can click on the File tab to go back to the Welcome Screen where you can then select Blank Workbook.

      

      
        
        Open an Existing Excel File

      

      

      One option for opening an existing Excel file is to go to where you have the file saved and double-click on it. If Excel isn’t already open, that will also launch Excel for you.

      For files I’ve worked with before, though, I prefer to open them through Excel. The bottom portion of the Welcome Screen lists the ten Excel files you had open most recently.

      Here you can see the top of that section and my three most recent files listed:

      
        
          [image: Expanded image of the Welcome Screen showing a list of recently opened files.]
        

      

      If the file you want is there, just click on the name and it will open.

      If it isn’t listed but you know you used it sometime recently, click into the white Search field and start typing the file name. When you see the file you want listed as a result, click on the name in the list.

      
        
          [image: Close up image of the search bar showing three possible files to select when “ad” was typed in.]
        

      

      Here, for example, I started to type “ad” because I was looking for my Advertising Tracker file. It gave me three recent files to choose from that have “ad” in the name. I can now click on the first entry in that list, which is the one I was looking for.

      A third option you have is to open a file through Excel by navigating to where the file is saved.

      To do that, click on the Open option on the left-hand side of the Welcome Screen. That will take you to the Open screen which has Workbooks listed by default but a Folders choice at the top under the Search field. Click on that. It will then show you a list of folders that contain Excel files you recently used:

      
        
          [image: Image of the Open screen when the Folders option is selected showing a list of recently-used folders.]
        

      

      Click on one of the listed folders to see any sub-folders or Excel files.

      
        
          [image: Image of the Open screen after a folder has been clicked on showing available Excel files. Arrows to the folder name and up arrow.]
        

      

      Once you find the file you want, click on it to open it. If you don’t find the file you want, you can use the up arrow next to the file path at the top to go back one level and see other folders.

      If that still doesn’t get you there, then click on Browse, which will bring up the Open dialogue box.

      
        
          [image: Image of the Open dialogue box in the foreground with the Open screen in the background with the Browse option pointed out.]
        

      

      At that point you can just navigate to where the file is saved on your computer like you would have outside of Excel. When you find the file, double-click on it, or click on the name and then click on Open at the bottom corner of the dialogue box.

      

      
        
        Pin A File

      

      

      I have certain files that I go back to over and over. One is that possibilities file you see in the screenshots above, which is actually my budgeting workbook (that is discussed in detail in Excel for Budgeting).

      I want to be able to find that immediately no matter how many Excel files I’ve opened in the meantime. The way to make that happen is to pin the file. That makes the file always available in a special list you can access from the Welcome Screen.

      To pin a file, hold your mouse to the left of the date modified, like I’m doing here for Easy Excel 365 Lookup Functions:

      
        
          [image: Listing of Recent files with Pinned menu option pointed out as well as pin image that indicates pinned files.]
        

      

      You can see that a text box appeared that says “Pin this item to the list” along with a thumbtack image. Left-click and the file will be pinned. That thumbtack image will remain for that file.

      To see your pinned files at any time, click on Pinned at the top of the file listing, and it will switch over to a list that is only your pinned files. Like so:

      
        
          [image: Pinned section showing two pinned files.]
        

      

      To unpin a file, just left-click on the pin for that file.

      

      
        
        Close a File

      

      

      The easiest way to close a file is to click on the X in the top right corner when you have the file open:

      
        
          [image: Top right corner of an Excel worksheet showing the X to use to close the file.]
        

      

      (And, really in Excel, almost anything you can close will have an X in that top right corner, so learn that one well.)

      If that was the only Excel file you had open, it will also close Excel.

      Another option is to use the control shortcut, Ctrl + W. Or you can go to the File tab and choose Close on the left-hand side menu. Both of those options will keep Excel open.

      

      
        
        Save a File

      

      

      Excel works pretty hard to make sure you don’t close a file without saving your changes, so any file that has a change in it that you try to close will pop up with a dialogue box asking if you want to save those changes:

      
        
          [image: Dialogue box asking if you want to save changes when you close a file without saving first.]
        

      

      That’s probably one of the easiest ways to save changes to a file that you’re done with. Just hit Enter when that dialogue box appears and your changes will be saved.

      Another option, for a file you’re not ready to close, is to use the save icon in the top left corner:

      
        
          [image: Top left corner of the Excel workspace showing the Save option in the Quick Access Toolbar.]
        

      

      You can also use the control shortcut, Ctrl + S.

      All three of the above work great for an existing file where you want to keep the file name, file location, and file type the same, which will be most of the time.

      But for a new file there are more steps. When you choose to Save using one of the above methods, Excel will present you with a Save dialogue box where it will ask you for a file name, location, and type. It suggests default values for you:

      
        
          [image: Save dialogue box with options for File name and location.]
        

      

      But it is very likely you will want a name other than Book1. That name will already be selected so you just need to type to change the name. The dropdown for location will show other recent file locations. To choose a location not available in the dropdown, or to change the file type, click on More Options. That will open the Save As dialogue box:

      

      
        
          [image: Save As dialogue box with list of folders in the center, navigation options on the left-hand side, and file name in the bottom section.]
        

      

      
        
        Save As for an Existing File

      

      

      There are going to be times where you have an existing file but you want to either give it a new name, save it to a new location, or change the file type. When that happens, go to the File tab and choose Save As from the left-hand menu.

      Click on one of the listed folder names or click on Browse to bring up the Save As dialogue box.

      The File Name field is where you can change the file name.

      The Save As Type is a dropdown menu where you can choose a different file type. The standard now is Excel Workbook which is also an .xlsx file. That will usually be fine. But you may run into somebody who needs an older file format. In that case, use Excel 97-2003 Workbook which is also an .xls file. (You may also inherit an older file that’s in .xls format and need to upgrade it so you can have the full benefit of Excel 2024.)

      The other file type you may run into is a .csv file type. A lot of data output is provided in that format. Excel is going to open it just fine most of the time, but it’s a good idea to save it as an .xlsx, Excel Workbook, format if you do any sort of calculations or manipulations with the data.

      To choose a new file location, navigate to that location using the side menu and/or folders, just like you would to find a file.

      

      
        
        Rename a File

      

      

      If all you want to do is change a file name and you don’t need to keep two versions of the file, then don’t use Save As. Instead, go to where the file is saved, click on the file name once to select the file, and then click on it again to highlight the name and make it editable.

      Type in the new name you want, click away, and you’re done.

      Keep in mind that a renamed file cannot then be opened from the recent files list in Excel. Excel will still be looking for that old file name, so won’t be able to find the file under its new name. If that’s important, your best bet is to rename the file and then immediately open it so the new name is listed in your recent files list.

      

      
        
        Move a File

      

      

      You also should not use Save As if all you really wanted to do was move a file. That also should be done outside of Excel.

      Go to where the file is currently saved. Click on it to select it, use Ctrl +X to cut, go to the new location, and use Ctrl + V to paste.

      If you’re not comfortable using control shortcuts, you can also select the file and then choose the pair of scissors in the top row of the dialogue box or right-click and choose the scissors from the dropdown menu to cut.

      You can then go to the folder where you want to place the file and click on the image for paste which looks like a stylized version of a clipboard with a piece of paper on it. You can also right-click and choose the icon from the dropdown menu that appears.

      

      
        
        Delete a File

      

      

      If you ever want to permanently delete a file, that also needs to be done outside of Excel. Go to where the file is located. Click on it and then click on the image of a trashcan in the top of the dialogue box. You can also right-click on the file and choose the trash can from there.

      Be careful that you only have the file you want to delete selected and not anything else. (As I have learned from personal experience.)

      If you do accidentally delete something you didn’t want to, and notice it immediately, use Ctrl + Z to Undo.

      Keep in mind that for most computers, a deleted file will be sent to the Recycle Bin and may remain there, capable of being restored, until you proactively go and empty that recycle bin. Excel won’t be able to open it though, and you’ll get an error message if you try to do so from the files list in Excel.

    

  


  
    
      
        
          
          

          
            NAVIGATING EXCEL

          

        

      

    

    
      Now it’s time to talk about how you move around within Excel. We’ll talk about how to actually enter values in the next chapter.

      

      
        
        Basic Navigation Within a Worksheet

      

      

      When you open a new Blank Workbook, Excel you will automatically start in Cell A1 of Sheet 1. For an existing file, you’re going to start where you left off. So whatever worksheet and cell where you last were.

      The easiest way to move to a different cell in a worksheet is to left-click on it.

      The arrow keys will also move you one cell in the direction of the arrow. So use the right arrow to go right, the up arrow to go up, etc.

      The Tab key will move you one cell to the right. Shift + Tab will move you one cell to the left.

      Enter will move you down. If there’s no data in your worksheet, you’ll go down to the next row in that same column. If you have data that is organized and you’ve been consistently completing that data across multiple columns row after row, then Enter might take you to the first empty column in that range in the next row.

      Here, for example, I have created a simple data table with three columns of data to enter. When I input the first set of values in Cells A2 through C2 and then hit Enter, it took me to Cell A3 not Cell C3. After I entered information in Cells A3 through C3 and hit Enter it took me to Cell A4.

      
        
          [image: Image of the top left corner of a worksheet showing how hitting Enter in Cell C3 when working in a table of related data will take you to Cell A4.]
        

      

      The PgUp and PgDn keys will also work to move you up or down one visible set of rows at a time.

      If the cell, row, or column you want isn’t visible, then use the scroll bars to get there. Clicking and dragging the dark gray bar is the fastest way to move when there is existing data, but if you don’t have data in those rows or columns yet you’ll need to use the arrows at the ends of the scroll bars.

      Another option is to use the scroll wheel on your mouse.

      Just remember with scrolling to click into an actual cell when you get to where you want to go, because otherwise when you type, hit Enter, use the arrow keys, etc. you will still be doing so from that last cell you were clicked into.

      

      
        
        Insert a New Worksheet

      

      

      To add another worksheet to your workbook, the easiest option is to click on the plus sign next to the name of your existing worksheet(s):

      
        
          [image: Image of the bottom left corner of the Excel workspace showing Sheet1 and next to it a plus sign that can be clicked on to insert a new worksheet.]
        

      

      This will insert a worksheet to the right of the one you’re currently on.

      You can also right-click on an existing worksheet’s name, and choose Insert from the dropdown menu. Click on Worksheet (it should be selected by default) and then OK when the Insert dialogue box appears. This will insert a worksheet to the left of the one you right-clicked on.

      Another option is to go to the Cells section of the Home tab, click on the dropdown arrow under Insert, and choose Insert Sheet from there.

      
        
          [image: Insert dropdown menu from the Cells section of the Home tab.]
        

      

      This will also insert a worksheet to the left of the sheet you are currently on.

      

      
        
        Select a Worksheet

      

      

      To select the worksheet you want to see, click on the name tab at the bottom of the workspace:

      
        
          [image: Image of the bottom section of the Excel workspace with three worksheets visible and an arrow to Sheet2 which is the current worksheet.]
        

      

      A selected worksheet will be white instead of gray and the name will also be underlined. See here that I have Sheet2 selected and Sheet1 and Sheet3 are more in the background.

      (It is possible to select more than one worksheet at a time. I do not recommend it for a beginner. If that ever accidentally happens, click on a different worksheet to unselect all currently selected worksheets. You can also right-click on one of the sheets and choose Ungroup Sheets from the dropdown menu.)

      

      
        
        Move a Worksheet

      

      

      To move a worksheet, simply left-click on the worksheet name and drag to where you want it to go. As you drag along the row of worksheets, you’ll see a little arrow that indicates where the sheet will move. Just let up on your left-click and it will drop into that new location.

      

      
        
        Rename a Worksheet

      

      

      Once you have more than one worksheet, chances are you’ll want to name them something other than Sheet1, Sheet 2, etc. To rename a worksheet, you can either double-click on the worksheet name, or right-click on it and choose Rename from the dropdown menu:

      
        
          [image: Image of the bottom portion of the Excel workspace with an indication to right-click on a worksheet name. Dropdown menu is visible with Rename pointed out.]
        

      

      Either option will highlight the name of the worksheet. From there just type in what you want the name to be and hit Enter or click away. You can use Esc to cancel if you decide you don’t want to change the name after all.

      There are restrictions on how long the worksheet name can be (31 characters) and what characters you can use. Excel 2024 won’t let you type past that point nor will it let you use one of the restricted characters, so if you were typing just fine and now can’t type something it’s probably safe to assume that’s the reason.

      

      
        
        Delete a Worksheet

      

      

      To delete a worksheet, right-click on the worksheet name and choose Delete from the dropdown menu. You can also select the worksheet and then go to the Delete dropdown menu in the Cells section of the Home tab and choose Delete Sheet.

      Excel will delete a blank worksheet immediately.

      If there is any data in the worksheet, Excel will show a dialogue box asking you to confirm the deletion. Click on Delete to proceed or click on Cancel if you want to double-check what’s in there first.

      

      
        
        Basic Navigation Between Worksheets

      

      

      If you have more worksheets than you can see at the bottom of the workspace, use the arrows on the bottom left corner to move the set of visible worksheets left or right by one sheet at time.

      Use Ctrl while clicking on the left or right arrows to move all the way to either end of your listed worksheets.

      

      
        
        Copy a Worksheet

      

      

      To keep one version of a worksheet where it already is and create a copy of a worksheet and move it somewhere else, right-click on the worksheet name, and choose the Move or Copy option from the dropdown menu.

      This will open the Move or Copy dialogue box:

      
        
          [image: Move or Copy (worksheet) dialogue box.]
        

      

      Check the box towards the bottom that says Create a Copy.

      You then need to tell Excel where to put the worksheet. If it’s in the current workbook, then click on the worksheet name that is one past where you want to place your copied worksheet. Click OK.

      If you want to place it in another workbook, use the dropdown menu at the top where it says To Book and select that workbook name.

      You can also just move it to a new workbook by selecting (new book) in the dropdown.

      To be listed in that dropdown, a workbook needs to already be open. If it isn’t, use Esc or Cancel, go and open that workbook, and then try again.

      

      
        
        Move a Worksheet to a Different Workbook

      

      

      The process to move a worksheet to a different workbook is the exact same as copying it, you just don’t check the box for Create a Copy.

      

      
        
        Select a Column or Row

      

      

      We already covered this in the terminology section, but I want to cover it again. To select an entire column or row, just click on the letter for that column or the number for that row. Here, for example, I have clicked on the letter “D” to select Column D:

      
        
          [image: Close up of the top left corner of an Excel worksheet showing Column D selected with an arrow to the D, indicating it should be clicked on to select the column.]
        

      

      You can see that the cells in that column are all now shaded and also the name of the column is colored differently.

      To select more than one column or row at a time, left-click and drag across the letters or numbers for those columns or rows. You can also click on the first column or row in the range, hold down the Shift key, and click on the last one. If they are not all touching, hold down the Ctrl key as you select each one.

      

      
        
        Delete a Column or Row

      

      

      To delete a column, row, or range of columns or rows, select them first and then right-click and choose Delete from the dropdown menu.

      You can also select them and then go to the Cells section of the Home tab and use the Delete dropdown. Choose Delete Sheet Rows or Delete Sheet Columns, as appropriate.

      

      
        
        Delete the Contents of Cells

      

      

      Delete will delete the content in all of a range of selected cells.

      Backspace will just delete the content in the first cell of the last cell range you clicked on.

      Another option is to go to the Editing section of the Home tab and use the Clear dropdown. Clear Contents will clear the text, formulas, etc. but leave the formatting. Clear All will delete the contents as well as any formatting.

      

      
        
        Delete a Cell in a Worksheet

      

      

      Deleting columns or rows is relatively straightforward, because everything else in the worksheet stays properly aligned. Everything that was in Column C may move to Column B, but it’s still all in one column.

      Deleting cells can be trickier because you’re taking part of a row or column and removing it. The other cells in the worksheet have to shift to fill that space. Since you’re usually not going to do this if you don’t have data in that worksheet, you need to pay attention to the rest of the data in the worksheet.

      If you only delete part of a row or column then data that has to move to fill the deleted space can get out of alignment.

      It is relatively easy in Excel to “break” your data. Let’s look at that little table I was building before:

      
        
          [image: Table of data with three columns and four rows of data.]
        

      

      This is a pretty basic table of data where I’m listing the author, title, and date read for some books on my shelf. You and I can look at that and know that everything on Row 3 belongs together. According to this made-up data, I read Contagious by Jonah Berger on 3/1/23, right?

      Now, here’s where the problem happens. If I delete Cell C3, Excel has to shift things somehow to fill in that gap. I can choose to shift cells left or to shift cells up. If I make the wrong choice and choose to shift up, I get this:

      
        
          [image: Table of data from before after a cell in Column C has been deleted and shifted the values in that column incorrectly so the data no longer matches.]
        

      

      See how the data broke? It now looks like I read that book on 4/1/21 instead, and that I read Linchpin on 7/6/22 instead of 4/1/21. I broke my data. In a normal data table that you create by inputting information in Excel, that can happen very easily.

      So when you delete cells in a worksheet, pay attention to what effect that will have on all of the data in the worksheet, not just the cells around what you delete.

      This is why sometimes it is best to delete an entire row or column to keep things like that from happening. It may also mean deleting more cells to keep everything together. If I’m deleting Cell C3, I really should delete Cells A3 and B3, too. (Or I could just remove the text in Cell C3, but not delete the cell.)

      Okay. Lecture over, let’s walk through how you actually delete a cell.

      Select the cell or cells you want to delete, and then right-click and choose Delete from the dropdown menu.

      
        
          [image: Dropdown menu visible when you right-click in a worksheet with the Delete option pointed out.]
        

      

      That will bring up the Delete dialogue box:

      
        
          [image: Delete dialogue box.]
        

      

      You have two choices there, shift cells up or shift cells left. How do you want to fill in that empty space? When your cell or cells are removed, do you want everything below that to move up, or do you want everything to the right to move over? The appropriate choice is going to depend on your remaining data.

      In our example above, I should’ve chosen to shift cells left. The rest of the table would’ve remained untouched if I’d done so.

      Note that you can also choose to delete an entire row or column using that dialogue box. It’s another way to do that without having to select the entire row or column.

      Another option is to select your cell(s) you want to delete and then use the Delete dropdown in the Cells section of the Home tab, which will also bring up the Delete dialogue box.

      

      
        
        Insert a Column, Row, or Cell

      

      

      Insert basically works like delete except the Insert dialogue box gives the option of shifting the cells right or down to make room for your inserted cells. Again, this only makes sense to do if you’re dealing with cells that already have information in them because the size of an Excel worksheet is fixed.

      You can either right-click on selected cells and choose Insert, or use the Insert dropdown in the Cells section of the Home tab.

      As with deleting cells, pay attention to your other data to make sure that you aren’t breaking your data relationships when you insert cells.

      

      
        
        Find Text

      

      

      I cover advanced find in Intermediate Excel 2024, but real quick, if you need to find text in a formula or cell in an Excel worksheet, you can use Ctrl + F to open the Find and Replace dialogue box. Type the text you need to find into the white space next to Find What and then click on Find Next. Excel will take you to the next cell that has that text in it.

      Find All will give you a list of all of the locations in your worksheet that have that text in a cell. You can then click on the entries in the list to move to each one.

      By default, Find works within one worksheet at a time not the entire workbook. It also is not case-sensitive and looks for the text you tell it to look for in any part of a cell. It does not look at the results of any formulas.

      One thing to be aware of in Excel is that it will search in columns or rows that are hidden, too. So sometimes you may think that Excel hasn’t moved to the next cell with that value in it, but it really has, it’s just not a cell that’s visible to you.

    

  


  
    
      
        
          
          

          
            INPUT AND DELETE DATA

          

        

      

    

    
      At its most basic, inputting data into Excel is very easy. You click into a cell and start typing. When you’re done, you hit Enter. Or tab. Or arrow or click to another cell.

      But there’s a lot more that can go into it, which is what this chapter covers.

      

      
        
        Undo

      

      

      My lifesaver when working in Excel is the ability to undo things. I use Ctrl + Z, which is the control shortcut to undo, all the time. You can use it multiple times in a row if you mess up and don’t realize it for a few steps.

      It does go back through each thing you did in order, so if you messed up ten steps ago, you’ll lose all ten things you’ve done since then. But better than not being able to, right?

      If you know up front that you have a lot of steps to reverse, you can use the Undo dropdown menu available in the top left corner of Excel:

      
        
          [image: Undo dropdown menu from the Quick Access Toolbar.]
        

      

      Click on the backwards pointing arrow once to undo your last step, or click on the dropdown arrow next to it and Excel will show you the last 100 things that you did in Excel.

      In the image above you can see that the last few things I did was zoomed in, added some borders to cells, changed a column width, and more. So if I want to undo that Bold of some text, I’d also lose all of that.

      I can do it, though. I just need to click on Bold and that step and everything that came after it will be undone.

      Undo is fabulous to use throughout Excel, not just when inputting data. It’s one of the easiest ways to undo mistakes when you’re learning.

      But there are a few places it doesn’t work well. For example, if you input the text, “October 4”, Excel will treat that like a date and a simple Undo will not change that cell back to text. 99 times out of 100, though, Undo is the way to back out of a mistake in Excel.

      

      
        
        Redo

      

      

      What if you Undo, like I just did, and then realize that was a mistake and want to Redo?

      You can either use Ctrl + Y to redo one step at a time, or you can use the Redo arrow up top, which will only be available to select if you already undid something:

      
        
          [image: Redo dropdown menu from the Quick Access Toolbar.]
        

      

      It’s the arrow that points to the right and it also has a dropdown menu. Click on a step in that list and it will redo each step in the list above the one you chose as well as that one.

      (Excel will highlight the entries in gray that it’s going to redo as you move your cursor over the list to make your selection.)

      Same thing with Redo as with Undo, it does them all in order, you can’t pick and choose.

      

      
        
        Esc

      

      

      Another little trick I like to use often is Esc. If I start typing a formula in a cell and it becomes a hot mess, I just use the Esc key to get away from whatever I was typing and start over.

      It’s also a good way to back out of something you’ve started. Say you copy some data and were going to paste it elsewhere but then change your mind, use Esc to be done with that.

      It will also turn off a tool like Format Painter.

      Between Undo and Esc that should get you out of 95% of the scrapes you get into. Think of Undo as “Didn’t mean to do that, sorry, can we go back?” and Esc as “Wait, let me just stop what I’m doing right now.”

      Also, if you’re ever inputting data and try to Undo and it doesn’t work, you may need to use Esc first to back out and then Undo from there.

      Okay. On to the inputting text tricks.

      

      
        
        Display The Contents of a Cell as Text

      

      

      If you start the text you enter into a cell with a minus sign (-), plus sign (+), or equals sign (=), Excel will think you’re about to enter a formula in that cell. Excel also tries very, very hard to recognize text (“October 2024”) as dates and convert them for you, often when you don’t want it to.

      Fortunately, there is a very simple workaround for these issues. Simply type a single quote mark at the start of the text you’re entering into that cell.

      So if you want to have an entry that looks like this:

      
        
        -Item A

      

      

      what you need to actually type is:

      
        
        '-Item A

      

      

      Or if you want:

      
        
        October 2024

      

      

      What you need to type is:

      
        
        'October 2024

      

      

      Simple as that. The single quote mark is not visible in the worksheet and it won’t be visible when you print either. It’s just a way to tell Excel “Leave this as is, please”.

      

      
        
        Include Line Breaks In a Cell

      

      

      Most people think of using Excel for numbers, but I actually use it for text a lot.

      For example, my current day job requires a lot of analysis of bank statements. Sure, bank statements include the dollar value, but just as important in that data is the name of the person who received or sent the money.

      Also, I’ve used Excel in the past for a complex analysis of credit agency regulations across various jurisdictions, because Excel has the ability to filter entries.

      Sometimes I want my text to appear on separate lines within one single cell. But you can’t just use Enter to make that happen, because Enter will take you to a new cell.

      The trick is to use Alt + Enter. If you hold down the Alt key and use the Enter key, Excel will create a line break within the cell. Like so:

      
        
          [image: Example of the same text in Column B with no line breaks and in Column C with line breaks added.]
        

      

      In the image above I used Alt + Enter twice for each break, once to move the text to the next line and once to create that blank line between the sections. See how it makes things much easier to read? Very handy to know.

      

      
        
        Auto-Suggested Text

      

      

      Within a column of data, Excel will by default try to help you by suggesting text that matches what you’ve entered before. Often when I’m entering data and have control over what I enter, I use this feature to speed things up. It only works with letters or combinations of letters and numbers (it doesn’t work with just numbers), so I may sometimes write something as ABC123 rather than 123ABC to save input time if I have that kind of control over my data.

      What it does is looks at what you’re entering and compares it to your previous entries. If what you have entered so far is a unique match for an entry above, Excel will suggest that entry for you. Let me show you:

      
        
          [image: Image of a table of data where in Cell A5 the letter j has been typed and Excel is suggesting the entry Joe Smith which is also in Cell A2.]
        

      

      Above is the table I created earlier for formatting data. I clicked into Cell A5 and typed the letter “j”. Excel automatically looked at the other values in Column A and suggested that the entry I want is “Joe Smith” since I only have one entry in that column that starts with a J.

      If I agree, I can hit Enter or tab or arrow away from the cell and Excel will populate Cell A5 with “Joe Smith”. I only had to type one character instead of nine. Great, right?

      If you have a value like 123ABC, though, Excel will not try to suggest anything until you type the “A” even if the only 123 entry is 123ABC.

      Also, Excel only does this if there’s a unique value it can suggest. So if you have “Joe Smith” in one field and “Joe P. Smith” in another, it won’t suggest anything until you get to “Joe P” or “Joe S”, because until that point there isn’t a unique value to suggest.

      Another nice thing about auto-suggested text is it carries over the formatting from the suggested entry. So I can write “Joe Smith” all nicely capitalized, but the next time around I just have to type “j” and not worry about capitalization.

      If Excel suggests a value that you don’t want to use, then just keep typing.

      

      
        
        F2

      

      

      This is probably a good time to mention F2. If you click on a cell and use F2, it will take you to the end of whatever text you have entered into that cell. This comes in very useful if you just need to make one small change at the end of a cell. So, say I have an entry for “Maria Castilla Ladaron” and I type M and the auto-suggested text gives me that full name, but I want to add “Hernandez” on the end. I can leave that cell and let Excel populate it with the “Maria Castilla Ladaron”, and then go back to the cell, use F2 to get right to the end of the text, and type in Hernandez. And done.

      I also will use this is if I have entries like Author A, Author B, Author C, and Excel isn’t recognizing that as a pattern for Auto Fill. I’ll copy Author A to all of my cells and then go back to the ones that should be Author B, Author C, etc. and use F2, to change that A at the end.

      

      
        
        Auto Fill

      

      

      Excel has the ability to recognize patterns and fill those in for you. Some patterns, it only takes one entry. Other patterns, it never figures out. Here is an example:

      
        
          [image: Image of the value January in Cell A1 and auto- fill suggested text in Cell A8 that says August.]
        

      

      In Cell A1 I entered the value “January”. I then left-clicked on the bottom right corner of that cell and dragged downward. As I dragged downward to Cells A2, A3, etc. Excel briefly showed me what value it thought I would want in each of those cells.

      Here you can see that I’m at Cell A8 and it’s suggesting August after having suggested February, March, April, etc. Perfect.

      If I then let up on my left-click, Excel will populate Cells A2 through A8 with the suggested values. Like so:

      
        
          [image: Complete auto fill values showing January through August.]
        

      

      I only had to enter January and then click and drag and Excel did all the rest of the work for me.

      I could have clicked and dragged to the right just as easily as I dragged downward. It would have populated values across Row 1 instead of down Column A.

      Obviously, not all patterns can be recognized with one value. If you have a custom pattern, you may need a few entries before Excel can identify it. Here I have three entries, “Book 1”, “Book 2”, and “Book 3”. I highlighted all three, clicked in the bottom right corner of Cell A3, and dragged, and Excel caught the pattern. You can see it will put “Book 9” in Cell A9.

      

      
        
          [image: Auto Fill example that started with Book 1, Book 2, Book 3 that suggests Book 9 for Row 9.]
        

      

      
        
        Copy Values Down a Column

      

      

      If you have a large data table, you can have Excel fill that entire column quickly by double left-clicking in the bottom right corner. As long as there is a column next to the one you’re trying to populate that tells Excel how far to go, it will auto-fill all the way down for you.

      I actually use this to copy values quickly. Excel will auto fill with a series of values. I then go to the bottom of the portion of the list that is visible on my screen and find what I’m going to call the Auto Fill Options widget:

      
        
          [image: Auto Fill Options widget visible at the end of an autofilled list.]
        

      

      There is a dropdown arrow next to that image. Click on it and you will see a list of options:

      
        
          [image: Auto Fill Options]
        

      

      To change the auto fill over to a copy of that starting value, just click on the circle next to Copy Cells. And done.

      

      
        
        How to Customize Your Excel Input Options

      

      

      My current employer uses Office 365, and I have noticed recently that Excel is getting a little too proactive in trying to auto fill values for me. As in, it’s doing it on its own without telling me, and not waiting for me to affirmatively tell it to do so. If you run into that issue, you can turn this off.

      To do so, go to the File tab, click on Options in the bottom left corner, and when the Excel Options dialogue box appears, go to the Advanced tab:

      
        
          [image: Excel Options dialogue box on the Advanced tab.]
        

      

      Uncheck the box for “Automatically Flash Fill”.

      If you like that Excel suggests a word for you like above with our “Jim Smith” then leave the Enable Autocomplete box checked.

      While we’re here. Go to the Data tab and you’ll see a section called Automatic Data Conversion:

      
        
          [image: Excel Options data tab with Automate Data Conversion section pointed out.]
        

      

      You may want to uncheck one or more of these boxes. For example, I work with zip codes a lot. Some of those have a zero at the start. I can either use the single quote mark ( ' ) to tell Excel to leave them alone, format the cell as a zip code, or I can uncheck the box for “remove leading zeros” and Excel will stop turning a zip code that is 01234 into 1234 on me.  (Theoretically.)

      Note that if you do that, the value stores as text not a number, which for zip codes is fine with me.

      I also deal with ISBN numbers which are fifteen digits long and which Excel loves to put into scientific notation. “12345678912345” becomes “1.23457E+13”, so I can uncheck that next box, too, although I just did so and it didn’t work.

      Oddly enough, when I clicked into the cell where I had the value, copied the value, and pasted it into another cell formatted as a text cell, where it still didn’t work, somehow the original cell started displaying properly. And then the second one did, too. (Excel is not always perfect. And sometimes they break things while working on other things. It’s a very old program with lots of layers of functionality that have been added or refined over the years, and occasionally there will be quirks. Sometimes it really is them not you. Although often enough it will be you. Or me as the case may be.)

      So those last two fixes may or may not help, but the Flash Fill one is a lifesaver. Turn that nonsense off.

      

      
        
        Delete Text From a Cell

      

      

      We already discussed how to use Delete to delete the contents of a cell and Clear to delete formatting as well. But if you don’t want to delete everything in a cell, but instead just edit part of the contents, then either double-click on that cell to be able to move to a specific spot in that text, or left-click on the cell and then use the formula bar.

      From wherever you are in that text in that cell Delete will remove one character (space, letter, number, etc.) to the right and Backspace will remove one character to the left.

      You can also select multiple characters in a cell and then use Backspace or Delete to remove your selection.

      

      
        
        Add More Text To a Cell

      

      

      You can add more text to a cell by double-clicking on it or left-clicking on it and going to the formula bar and typing what you need in the spot where it’s needed.

      By default, the formula bar will only show one line of text. I usually double-click on the cell itself in those situations, but there is an arrow at the end of the formula bar that will expand that to three lines and provide up and down arrows for you to use to see the rest of the text.

      

      
        
        Freeze Panes

      

      

      One final trick for you with respect to inputting data is to know how to use Freeze Panes. Most tables of data you create are going to have a header row that tells you what is in each column. Some may also have a column or two on the left-hand side that tells you what the row of data covers, like a student or customer name.

      But as you enter more data in Excel, those rows or columns will disappear. When you get to Row 652 of your data, Row 1 isn’t going to be visible anymore. Fortunately, you can use Freeze Panes, which is available in the Window section of the View tab, to tell Excel to keep certain rows or columns always visible.

      The dropdown menu for Freeze Panes will give you the choice to Freeze Panes, Freeze Top Row, or Freeze First Column.

      
        
          [image: Freeze Panes dropdown menu.]
        

      

      Freeze Top Row will freeze the top row in your visible workspace. So if you want to always be able to see Row 1, be sure it’s showing on your workspace before you choose this option.

      If you have a data table that starts on Row 10, you can scroll in your workspace until Row 10 is the top row visible, and then choose this option. That will make Rows 1 through 9 permanently hidden until you turn it off, but you will have Row 10 visible at the top of the worksheet even when you’re on Row 710.

      Same concept works for Freeze First Column. It will keep the first column that was visible in the workspace when you turned it on visible as you scroll to the right. Any columns to the left of that will be hidden until you turn Freeze Panes off.

      The final option, Freeze Panes, lets you freeze both columns and rows at the same time as well as more than one row or column at a time. To use this one, arrange your workspace so that the columns and rows you need to be able to see at all times are visible, and then click into the first cell that you don’t want to have to see (so the one to the right and below the rows and columns you want frozen), and then choose Freeze Panes.

      After you turn on freeze panes, you may want to scroll in each direction to make sure that what you’re seeing is what you intended to be able to see/not see.

      To turn off freeze panes, just go back to that dropdown. You’ll see an Unfreeze Panes option. Click on it.
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